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Scribe 4 

Scribe 4 is an optimally flexible data analysis program that permits users to label events 
in live observations or in recorded videos, summarize event timings, and play back 
labeled events in customized configurations. The following is an introduction to the 
Scribe 4 software that illustrates the intuitive interface design.  

Scribe 4 is written in java script and runs on Intel Macs (OS 10.6 and later) and PCs 
(Windows XP and 7) inside the Chrome, Safari, and Firefox browsers. You must first 
install the latest version of Chrome, Safari, or Firefox in order to use Scribe. These 
browsers are available at <http://www.google.com/chrome/>, 
<http://www.apple.com/safari/>, and <http://www.mozilla.com/en-US/firefox/new/>. 

Scribe no longer plays all types of QuickTime movies in all three of these browsers, and 
instead uses videos that conform to HTML5. The Safari browser will play QuickTime 
movies (.mov), MPEG4 movies (H.264), and AVI movies in Scribe. The Chrome 
browser will play MPEG4 movies (H.264) in Scribe. Most video software (including 
QuickTime) provides a save option for saving QuickTime movies as MPEG4 (e.g., in the 
latest version of QuickTime, version 10.0, go to the Share menu and select iTunes and 
then AppleTV). Firefox will play only Theora/Ogg movies in Scribe. If you choose to use 
the Firefox browser with videos that were recorded in another format, there is a free 
video converter available from Miro at <http://www.mirovideoconverter.com/>. 

A note about the configuration of the software. The Scribe4.2 folder contains a file called 
scribe4.htm and two folders, called js and scribe_files. The folders contain the software’s 
javascript code; the scribe4.htm file is the program file. All user data are saved in files 
with .xml tags. These are where your data live. After you finish an observation, you will 
save your data in a file with a name that you select followed by a .xml tag (e.g., 
mydatafile.xml). 

Getting Started 

To begin, open Chrome, Safari, or Firefox. From the File menu, select Open File… and 
choose the scribe4.htm file that is in the Scribe 4 folder. You may expedite the opening of 
Scribe 4 in the future by making it a bookmark and placing it on the Bookmarks toolbar 
in your browser. Thereafter, you may start using Scribe 4 simply by opening your 
browser and selecting the Scribe 4 Bookmark.  

The Scribe 4 interface is arranged in six windows, each of which is accessed by clicking 
on a tab in the top ribbon of the browser window. The windows are: Open, Setup, 
Observe, Review, Save, and About. The software functions in each window are described 
below. 
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A note about the configuration of all of the windows in Scribe 4. All words that appear in 
blue text have a function, most of which are readily apparent (e.g., Add Subject, Add 
Behavior, Hide, Remove). If it’s in blue, clicking on it does something. For example, 
clicking on the blue names of behavior codes will allow you to rename them. Clicking on 
a blue column heading will sort the columns by the variable in the heading. You get the 
idea. 

The Open Window 

 

This is the first window visible when you open the scribe4.htm file. From this window 
you may start a new Scribe 4 file by clicking on the New Scribe File button, or you may 
open an existing Scribe 4 file by (1) clicking on the Open Scribe File button, (2) locating 
an existing Scribe 4 xml file (its name will appear in the window to the left of the Open 
Scribe File button after you click Open in the dialogue box), and (3) clicking Load Scribe 
File.  

Clicking the New Scribe File Button or the Load Scribe File button will take you to the 
Setup window. 

The Setup Window 

 

The Setup Window is where you first indicate whether you will be observing a movie file 
or a live event. In the upper portion of the Setup Window is a Time Base pulldown menu. 
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Select Movie (the default) if you intend to observe recorded events from a movie. Select 
Timer if you intend to use Scribe 4 to record a live observation in real time. 

If you are observing a movie (MPEG4 in Chrome and Safari, and Theora/Ogg in 
Firefox), click the Load Movie button and locate the movie file, and, after you locate the 
file, click Open in the dialogue box. The name of the file and its path will appear in the 
window to the right of the Load Movie button. [Note: Scribe 4 will not load movies that 
have a pound sign (#) in the file name.] 

You may use the < > button in the center of the browser window to resize the movie now 
or at any time. Simply click and drag to the desired configuration. 

The Scribe 4 observation codes are organized in terms of Subjects and Behaviors. You 
may add any number of subjects in your observation session, and each subject may have 
any number of behaviors associated with it. 

_________________________________________ 

To begin, click the Add Subject button. You will be asked to name the subject, and after 
typing a name and clicking OK, a new subject pane will appear in the right side of the 
browser window. Note that you can change the name that you select at any time. 

From the New Subject pane that you just created, click the Add Behavior button. You 
will be asked to name the behavior, and after doing so and clicking OK, a new behavior 
line will appear in the subject’s pane. 

You can continue to add subjects and behaviors until all of your observation codes are set 
and you are ready to observe. Subjects and behavior codes may be added even after you 
have begun entering data from a movie. 

You may reorder the behaviors as they appear in the table by clicking the blue order 
numbers in the column labeled Order and retyping a new sequence number for the 
behavior you wish to reposition. The sequence numbers of the other behaviors will be 
adjusted automatically. Note that the order in which behaviors appear in this window also 
determines the order in which behaviors appear in the Review window. Again, the order 
may be changed at any time. 

The Abbreviation column gives the short name of the behavior code that will appear on 
the timeline in the Review window. Click on the blue abbreviated code to change it. 

The Key column indicates the keystroke associated with each behavior. During an 
observation, events can be recorded either by clicking with the mouse or by pressing 
designated keystrokes. Designate a key command by clicking on the blue NA (not 
assigned) and pressing the key command when requested. If you intend to enter data only 
using the mouse, there is no need to assign keystrokes. 

Click on the white rectangle in the Color column to assign a color to the behavior code. 
The color you select will be associated with the behavior in both the button interface in 
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the Observe window and in the Timeline in the Review window. There are way too many 
colors to choose from. 

The Timed column indicates whether a given behavior code represents a point in time 
(unchecked) or a timed event (checked). Untimed events mark points in an observation. 
Timed events mark the start- and endpoints and durations of events in an observation. 

After you have created a number of different behavior codes in the Setup window, you 
may combine selected behavior codes to form behavior code groups. For example, codes 
for Individual Singing and Group Singing may be combined in a behavior group called 
Singing). Grouping behavior codes in this way will create additional options for replay in 
the Review window chronology (described below) and will create summary data for the 
behavior groups in the Review window summary (also described below). 

To create a behavior code group, select Groups from the Display pulldown menu in the 
upper right corner of the Setup window. Then click on the Add Group button. You will 
be prompted to assign a name to the new group (you can edit the group name at any 
time). Click Add Behavior and a pulldown menu with the list of individual behavior 
codes will appear. Select a behavior code to include in the group. Repeat this action until 
all of the individual behavior codes that you wish to be included appear in the group’s 
list.  

At any time, you may display the behavior codes in the Setup window either by groups or 
by subjects by selecting the Groups or Subjects options from the Display pulldown menu. 

The Observe Window 

The Observe Window provides two different views of the event codes, each of which 
displays a different arrangement of the event codes in physical space. From the Mode 
pulldown menu, select Table and you will see the event codes displayed in a table similar 
to the one in the Setup Window.  

 

When recording data in Table view, you enter data during the observation by clicking 
anywhere on the line of each event code or by typing the event code’s assigned 
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keystroke. As you record data in the Table Mode you will see to the right of each event 
code the Start and End times of the most recently recorded instance of that event code. 
The column labeled Events/Current Pass shows the number of instances of each event 
code that were recorded during the most recent viewing (“pass”) of the tape (a new pass 
begins each time you press the Begin Data Entry button). The total number of instances 
of each event code (i.e., all instances that have been recorded throughout multiple passes) 
appears in the column labeled Events/Total.  

Now from the Mode pulldown menu select Buttons and you will see the event codes 
arranged in buttons with the corresponding colors of the individual events.  

The panes for each subject and the buttons for the individual behavior codes are 
moveable and resizable. To move a pane or a button, simply click and drag. To resize a 
pane or a button, hold down the shift key, click and drag. When you have finished 
arranging the Buttons interface, click the blue Lock All to ensure that the buttons stay in 
place. 

 

Note that in both the Table Mode and the Button Mode you can control the movie using 
the movie controls that appear beneath the movie window. You may start and pause the 
movie or use the slider to locate a particular location in the movie at any time. The 
controls are linked to the Play/Pause and Rewind buttons that appear above the Table and 
Button views in the Observe window.  

To begin entering data, locate the start point in the movie where you will begin recording, 
then click the Begin Data Entry button. This will start the movie playback. Note that you 
may begin data entry at any point in the movie. When you are finished entering data, 
click End Data Entry. If you intend to record data from multiple passes through the same 
portion of the movie, you can click the Pause button at any time and either rewind the 
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movie or move the slider to a different location in the movie, then click Resume to 
continue entering data. 

Inserting Annotations 

You may insert text annotations at any point in an observation by clicking on the Add 
Note button in the Observe window. When Data Entry is active (i.e., after the Begin Data 
Entry button has been clicked an the movie is playing) clicking on the Add Note button 
pauses the movie and brings up a text window in which you may type your annotation. 
When you click the Done or Cancel buttons in the Add Note text box, the movie resumes 
after a 1 second delay and Data Entry remains active.  

You may also Add Notes when Data Entry is inactive (i.e., before you click Begin Data 
Entry and when the movie is not playing). Use the movie slider to find the location in the 
movie where you would like to insert the annotation. Click the Add Note button and type 
your annotation in the popup text window. Click Done when you are finished.  

Annotations will appear in all of the Review Window formats described below. 

The Review Window 

You can review your data in three different formats, all of which appear in the Review 
Window: (1) a Chronology of event codes, (2) a Timeline of event codes, and (3) a table 
of Summary data. Each of these views is described separately. 

 

The Chronology. The Chronology is simply a chronological list of event codes recorded 
during the observation. The list displays for each event the sequence number (the ID 
column), the Subject name, the Behavior name, the Start and End times (which for 
untimed events will be the same number), and the Duration (which for untimed events 
will be 0:00). The event codes in the Chronology can be sorted by any variable simply by 
clicking on any of the blue column headings (i.e., the list can be reordered by Subject 
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name, Behavior name, Start Time, End Time, or Duration). Click the blue ID column to 
return to the original order. Sorting by variables does not change any of the stored data.  

Editing event codes. From the Chronology, you can change the event codes by clicking 
on the blue text of the Behavior name, the Start time, or the End time. Clicking on the 
Behavior name will bring up a pulldown menu from which you may select a new 
behavior code from the list of behavior codes that you created in the Setup Window. Note 
that from this menu you can select from all behavior codes for all subjects. So by 
changing the behavior code, you can also change the subject.  

Deleting event codes. From the Chronology, individual event codes can be deleted by 
clicking the word Remove that appears in the rightmost column in blue text. Clicking the 
Remove column heading will delete all event codes. 

Playing the movie with event codes. The Chronology provides multiple options for 
playing back the movie based on the event codes in the data file. Note that the Play/Pause 
button and the slider beneath the movie are operative. You may select a desired location 
and begin playback using these controls. You may also control playback using the Play, 
Pause/Resume, and Rewind buttons that appear above the Chronology list. 

You can control the actions of the Chronology by using the View and Play pulldown 
menus. The View menu determines which event codes are visible in the Chronology list. 
The Play menu determines which event codes are played during playback. 

Selecting events to view in the Chronology list. Immediately above the Chronology list is 
the View pulldown menu. This menu determines which behavior codes are visible in the 
Chronology list. You can select all of the behaviors of a given subject or behavior code 
group, or all instances of a single behavior code by selecting from this menu. You may 
choose to display combinations of behavior codes by checking event codes in the 
Checkbox column (to the right of the Duration column) and then choosing View Checked 
from the pulldown menu. You can check all event codes in a given view by clicking the 
checkbox in the column heading. Regardless of which view you choose, checked event 
codes remain checked until you uncheck them, even when you change views. Remember 
that you can check all or uncheck all events in a given view by using the checkbox in the 
column heading. 

Selecting individual events for playback. You can play any coded behavior by clicking on 
the blue Play text on the right of each behavior code line. This is most convenient for 
playing back individual events. If you wish to play back multiple events… 

To the right of the Play button above the Chronology list is a pulldown menu with three 
options: View, Checked, and All. Selecting Play View plays back all of the event codes 
that are visible in the Chronology list. Selecting Play Checked plays back only the event 
codes that you marked with checks in the Checkbox column (to the right of the Duration 
column), regardless of whether they are visible in the Chronology list. Selecting Play All 
plays back the entire movie. 
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The Timeline. You may view a graphical representation of the event code data in the 
Timeline. Data from each subject appear in a separate line of the Timeline. For each 
subject, timed events are depicted as colored bars above the line, and untimed events 
(markers) are depicted below the line. You may zoom in or zoom out to show more or 
less of the Timeline in the window. You can play an individual event by clicking on its 
symbol in the Timeline.  

Note again that the Play/Pause button and the slider beneath the movie are operative. You 
may select a desired location and begin playback using these controls. You may also 
control playback using the Play, Pause/Resume, and Rewind buttons that appear above 
the Timeline. 

The View and Play controls in the Timeline work just as they do in the Chronology. 
Immediately above the Timeline is the View pulldown menu. This menu determines 
which behavior codes are visible in the Timeline. You can select all of the behaviors of a 
given subject, or all instances of a single behavior code by selecting from this menu. All 
of the data in the Timeline and Chronology are linked, so you may choose to display 
combinations of behavior codes in the Timeline by checking event codes in the Checkbox 
column in the Chronology (to the right of the Duration column) and then choosing View 
Checked from the pulldown menu in the Timeline. You can check all event codes in a 
given view by clicking the checkbox in the column heading. Regardless of which view 
you choose, checked event codes remain checked until you uncheck them. Remember 
that you can check all or uncheck all events in a given view by using the checkbox in the 
column heading. 

The + and – Zoom buttons allow you to expand or contract the Timeline for easier 
viewing. If the length of the Timeline exceeds the width of the window, the Timeline will 
scroll during playback. A cursor indicates the location of the movie playback. 

Click the Print button to bring up a new window with a printable Timeline. The printed 
Timeline will appear just as it does in the Print window. You can change the appearance 
of the Timeline using the zoom buttons before you click the Print button. You should 
experiment to determine the optimal zoom setting for printing the Timeline. 
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The Summary. The Summary window presents a table of values for the events that you 
recorded during the observation. To the right of each event code name are columns that 
give the Frequency (the total number of events over the course of the observation period), 
Rate per minute (the rate of occurrence for a given event code over the course of an entire 
observation; i.e., total number of events divided by the total duration of the entire 
observation), Total Time (sum of the durations of all instances of an event over the 
course of the entire observation period), Percent of observation time (the sum of all the 
durations of a given timed event code, expressed as a proportion of the duration of the 
entire observation), Mean episode duration (the arithmetic mean duration, averaged 
across all instances of a given event code), and the Standard Deviation of the episode 
durations. 

Time data in the Summary may be expressed either as minutes-and-seconds or as seconds 
by choosing from the Time: pulldown menu. The minutes and seconds option may be 
more useful for discussing observations with students; the seconds option is useful for 
combining data from several observations in a spreadsheet analysis.  

Creating individual summary reports for shorter time intervals within a longer 
observation. When you are finished entering data, you may create separate summary 
tables for selected intervals of time within the full observation period, allowing you to 
generate detailed analyses of one or more segments of an observation episode without 
having to recode the video. First, from the pulldown menu in the upper right corner of the 
Review pane, select Display: Chronology. Then, click the New button to create a new 
summary. A dialogue will appear in which you can label the new summary and select the 
range of events that the summary will encompass. Select the range using the tabs on 
either end of the slider.  
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The events to be included in the new summary will be highlighted in the Chronology. 
Note that all of the highlighted events in the Chronology window will be included in the 
new summary table. Events that are not highlighted will not be included. Since the order 
of events in the Chronology is determined by start times, a timed event that begins before 
the highlighted selection will not be included in the new summary, even if the end time of 
the event falls within the highlighted summary range. You may edit the name and the 
range of any new summary by selecting it from the Summary pulldown menu in the 
Chronology, and clicking the Edit button. 

Custom summary tables will appear below the full summary table in the Summary 
window (select Display: Summary). Note that any changes to the parameters of custom 
summaries must be made from within the Chronology. 

Printing and exporting. You may print the Summary window by clicking on the Print 
button above the Summary table, which will bring up a new window with the Summary 
table, and then using the print commands in the browser menu. 

You may export the Summary data for pasting in a spreadsheet by first clicking on the 
Export button, which will bring up a new window with all of the Summary data in a 
single row. Next, you must copy these data and paste them into a text file and save the 
file on your hard drive. Finally, you can open this file with Excel or another spreadsheet 
program and indicate that individual fields are delimited by commas. Your data from the 
observation will appear with all of the observation data in a single line of the spreadsheet 
with each data point in its own column.  
Here’s an example of the first four behaviors in a Summary table… 

 

…and the same data as they’ll appear in the text file (in this case, in TextEdit)… 

 

…and finally as they’ll appear in the spreadsheet. 

 



Scribe 4 Manual   12 

Copyright © 2011 Robert A. Duke. All rights reserved. 

Saving Your Work 

You may save your work at any time. You must begin by clicking the Save tab in the 
Scribe 4 window. Do not use the Save command in your browser’s File menu.  

Opening Saved Scribe 4 Files 

Once you’ve saved your data file as described above, you can open it only from the 
Scribe 4 Open window. To open a saved Scribe 4 data file (e.g., mydatafile.xml), first 
open the scribe4.htm file in Safari, Chrome, or Firefox. Scribe 4 will default to the Open 
window. From there follow the instructions described above for opening files. 


